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W E L C O M E  T O  T H E  

Cloud 9 Onboarding Guide
We’re excited to welcome you to Cloud 9. This resource is designed to 
help your ortho practice confidently onboard, set up, and begin using 
Cloud 9’s cloud-based practice management system. Whether you're 
transitioning from another platform or starting fresh, this guide 
will walk you through each step to ensure a smooth and successful 
onboarding experience.

Purpose of the Guide

The goal of this guide is to support your team throughout the onboarding and 
configuration of Cloud 9. It offers clear documentation and resources to help 
you stay organized and transition smoothly into daily use. You can also rely on 
it as a reference throughout your onboarding journey, with key items to review 
before meetings and revisit during calls.

Who Should Use This Guide

This guide is intended for anyone involved in the Cloud 9 onboarding process. 
This includes:

• Ortho professionals who will use the system daily
• Project leads managing the rollout
• Operational leads coordinating timelines and team responsibilities

How To Use This Guide

Think of this as your roadmap for the Cloud 9 onboarding process. It provides 
helpful resources, outlines what to expect during each phase, and keeps your 
team aligned with assigned tasks. Several sections are designed to help you 
prepare for meetings, so reviewing them ahead of time will support 
productive discussions and informed decisions. You’ll also find homework 
items—tasks your team completes independently between onboarding calls.

If you need help or something isn’t covered, your Implementation 
Coordinator (IC) is available to support you.
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Preparing for 
Onboarding 

This section gives you a clear overview of how your 
Cloud 9 onboarding will be organized and supported.

Objectives:
1. Understand your Planet DDS resources 

Meet the Planet DDS team involved during implementation and post 
go live.

2. Define your internal team
Identify key roles on your side and what each person is responsible for.

3. Get familiar with the onboarding phases
Review the structure of your journey and what happens in each phase.

4. Learn how to unlock strategic value
See how our governance framework supports long-term success.

5. Track milestones
Reference key checkpoints from start to finish.

6. Prepare for change
Learn how to support your team through organizational change.



Your Planet DDS Support Teams

• Main point of contact 
• Schedules meetings and tracks action 

items to completion
• Works with your team to complete 

setup and establish workflows
• Reviews initial data conversion for 

auditing purposes

Implementation

• Responsible for data, document, 
and image conversions from your 
existing systems

Conversion

• Ongoing support and resources to 
optimize your Cloud 9 journey

• Provides post go live support for 
training-related topics

Account 
Manager

• Dedicated resources for any questions 
or troubleshooting needsSupport
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• Facilitates training sessionsTraining
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It’s a Team Effort: Client Resource Needs

P R O J E C T  L E A D

• Primary contact for 
implementation team

• Complete system setup for 
account and practices

• Ensure team is adhering to 
milestones and deadlines

• Attend setup and 
implementation sessions to 
ensure successful onboarding

C L I N I C A L  L E A D

• Establish clinical operations 
policies and processes  
(e.g., define clinical note 
templates and consent forms)

• Assist with clinical and 
imaging configuration

• Participate in clinical 
training discussions and 
setup sessions

O P E R A T I O N S  L E A D

• Understands, adapts, and 
develops standardized 
practice workflows 

• Partner with Planet DDS team 
to develop training approach 
and plan

• Organize training sessions

• Ensures team completion 
of Cloud 9 Learning 
Center trainings

T E C H N I C A L  E X P E R T

• Assists with data extractions 
and conversions from 
legacy platforms

• Work with Planet DDS to 
install imaging software and 
test hardware

• Provide technical support 
during implementation

E X E C U T I V E  C H A M P I O N :  Final decision-maker. Provides strategy and 
insights. Supports implementation success. Recommends the champion attend 
recurring sync meetings and stay involved throughout the onboarding process.
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AI-POWERED CEPH TRACING AND 3D IMAGING, BUILT DIRECT LY INTO CLOUD 9

�Cloud 9 for the Orthodontist

Cloud 9
for the Orthodontist
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Save Time, Increase Efficiency

• Access one central, cloud-based 
patient record that contains all 
information from patient visits across 
the organization.  

• Log in from anywhere, any time with 
appropriate user permissions.

• Easily generate letters, case review 
links, and debond certificates. 

Collect More Revenue

• Present customized payment 
options with the Financial 
Arrangements case presentation 
slider bars.  

• Generate practice-branded 
contracts for electronic signature.  

• Securely save on file a primary and 
a secondary method of payment for 
approved auto-debiting.

• Transactions auto-post to the 
patient ledger, providing seamless 
revenue recording.   

• Automated text and email 
payment reminders include link 
to patient portal.



AI-POWERED CEPH TRACING AND 3D IMAGING, BUILT DIRECT LY INTO CLOUD 9

�Cloud 9 for the Practice Manager

Cloud 9
for the Practice Manager
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Save Time, Increase Efficiency
• Access one central, cloud-based 

patient record that contains all 
information from patient visits across 
the organization.  

• Easily set up letter templates to merge 
and send out.

• Generate and send insurance claims 
electronically from within Cloud 9.

Communicate Easily 
with Patients
• Set automated, fully 

configurable text and 
email appointment 
reminders that reduce 
no-shows and cancellations.   

• Keep patients from 
slipping through the 
cracks with Patient 
Spotlight tracking and reports.  

• Create event-based messaging sequences based on the appointment 
type and outcomes.   

• Route text messages to appropriate team members for responses  

• Send automated messages for birthdays, promotions, office updates, etc. 

• Enjoy two-way texting directly from Cloud 9 patient profiles with a permanent 
record of the conversation. 



AI-POWERED CEPH TRACING AND 3D IMAGING, BUILT DIRECT LY INTO CLOUD 9

�Cloud 9 for the RCM Coordinator

Cloud 9
for the RCM Coordinator
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Save Time, Increase Efficiency

• Present customized payment options 
with the Financial Arrangements 
case presentation slider bars.  

• Assign contracted insurance rate and 
eligible office discounts.  

• Customize the downpayment amount 
and the monthly payment plan.

• Generate practice-branded contracts 
for electronic signature.   

• Securely save on file a primary and a 
secondary method of payment. 

• Set-and-forget automated payment 
processing schedule. 

• Auto-post transactions to the patient ledger.  

• Send automated text and/or email messages to patients to let them 
know the payment has been processed. 

• Automate text and email billing reminders with link to payment portal for 
patients without card-on-file.

• Receive alerts if there is an outstanding balance during patient checkout.

Enjoy Robust Reporting

• Track key performance indicators (KPIs) to make data-driven decisions. 

• View individual practice data and roll-up data to identify trends and issues.

• Receive full daily data downloads for deeper insights.

• Build custom reports via the Data Miner.



AI-POWERED CEPH TRACING AND 3D IMAGING, BUILT DIRECT LY INTO CLOUD 9

�Cloud 9 for the Treatment Coordinator

Cloud 9
for the Treatment Coordinator
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Save Time, Increase Efficiency

• Access one central, cloud-based patient 
record that contains all information from 
patient visits across the organization.  

• Apply exam questionnaire and treatment 
card templates specifically designed 
for ortho. 

• Save time with exam questionnaire answers 
that autopopulate the treatment card.

• View native 2D imaging with presentation 
tools direction in Cloud 9.

Collect More Revenue

• Present customized payment options 
with the Financial Arrangements case 
presentation slider bars.  

• Generate practice-branded contracts 
for electronic signature.   

• Securely save on file a primary and a 
secondary method of payment. 

• Transactions auto-post to the patient 
ledger, providing seamless revenue 
recording. 

• Automated text and email payment 
reminders include link to patient portal.



Customer Onboarding Journey

Launch

System 
Setup

Conversion

Go Live!

Post 
Live 

Support

• Introduce Team
• Review Key Events, Dates, & 

Expectations 
• Plan approach to Onboarding 

• Setup discovery call
• Guided setup sessions
• Discuss Best Practices
• Complete integration setup

• Trial conversion(s)
• Final conversion(s)
• Complete audits

• Instructor-led training
• Data cleanup
• Enable Integrations

• Office hours for Q&A
• Customer conversion and 

implementation sign-off
• Resources and continued support
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Unlock Strategic Value

At Planet DDS, we’re here to make your onboarding experience smooth 
and reassuring.

Our project governance framework is built to give you confidence every step of the way—with 
real-time visibility, proactive risk management, and open, transparent communication. We’re 
committed to making your implementation strategic and successful.

B E N E F I T D E S C R I P T I O N

Visibility & Control
Real-time insights into project status, risks, and 
milestones. Enables informed, 
proactive decision-making.

Proactive Risk Management
Early identification and mitigation of risks. 
Structured review processes for accountability.

Swift Problem Resolution
Clear escalation paths minimize delays. Fosters a 
culture of continuous improvement.

Stakeholder Engagement
Regular, transparent communication builds trust. 
Assigns clear ownership for decisions and 
deliverables.

Key Takeaway:
Project governance is our toolkit for delivering value, managing risk, 
and achieving strategic success.
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MILESTONE
OWNER

PDDS CLIENT

Complete System Workflow Session X

Configure your Cloud 9 URL X

Configure Planet Integrations
(Planet DDS Pay, Cloud 9 Connect, etc.) X

Planet DDS Pay Launch Call X

Complete Cloud 9 Learning Center Sessions
(Required self-guided training) X

Initial Trial Data Conversion X

Complete Trial Data Audit and Submit Findings X

Complete Data Mapping Documents X

Configure third party integrations
(, Cloud 9 Signature, etc.) X

Final Conversion
(Data and Imaging, Including Audits) X

End User Training 
(General, Scheduling, Clinical, and Financial) X

Complete Data Cleanup X

Go Live with Cloud 9 X

Post Live Support X

Complete Token Transfer 
(If available) X

Key Project Milestones
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Managing Organizational Change
Switching to a new practice management system can be a challenging step forward. 
Thoughtful planning and communication can make the transition smoother. Our 
change management approach ensures your team stays informed, supported, and 
ready for success.

Key Recommendations

Build a Communication Plan
Keep partners and stakeholders aligned with clear, consistent updates.

Establish Governance
Set up processes for clinical, operational, and system requests, including SOPs.

Manage Escalations 
Surface and resolve issues quickly before they affect your practice.

Share Updates
Share regular progress reports and key milestones.

Manage through Change
Proactively address concerns and support staff through change.

Celebrate Wins
Build momentum by recognizing progress and success.

Our Approach

Evaluate Readiness
Assess each office’s readiness to adopt Cloud 9. Use metrics to group and sequence 
offices for early wins and long-term success.

Tailor Strategies 
Customize plans based on each office’s needs. Identify champions, address concerns, 
and promote inclusion, education, and outreach.

Mitigate Risks
Identify adoption risks and create strategies that build confidence and ensure a 
smooth transition.
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Communication Plan

To ensure a smooth Cloud 9 rollout, we keep all stakeholders informed, engaged, 
and prepared:

• Share goals like improved patient care, streamlined admin tasks, stronger 
compliance, and better billing accuracy.

• Highlight training opportunities and the support available before, during, and 
after go-live.

• Show how standardized processes create long-term efficiency and value.
• For equity partners, reinforce the benefits of scaling on a unified platform.

Together, we’ll drive adoption, build confidence, and celebrate milestones as your practice 
moves forward with Cloud 9.

Managing Organizational Change

Check out our e-books:

Change Management for DSOs 
and Dental Group: 

Laying the Groundwork

Change Management for 
DSOs and Dental Groups: 

Leading Teams Through Transition

Read Now

Read Now
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S E T U P

Getting Cloud 9 Ready

As part of onboarding, we’ll begin with a series of 
calls designed to get your account fully configured 
and ready for use. Each call follows a clear agenda 
to ensure a smooth transition. 

We will:

• Begin with a discovery session.

• Complete account and office setup.

• Proceed to insurance and fee schedules.

• Continue with clinical setup.

• Address any miscellaneous setup activities.

• Conclude with integration setup.

These steps collectively ensure the system is 
tailored to your practice needs.



Overview: Setup Calls

• Client Operations Review
• Best Practice Recommendations
• Determine Optimal System Setup
• Develop Training Plan

• Practice and Location(s)
• Employees & Permissions
• Providers
• Schedules
• Procedure Codes

• UCR Fee Schedule
• PPO, HMO, and Other Schedules
• Fee Schedule Assignment
• Insurance Plan Entry

• Clinical Note Macros
• Consent Forms
• Medical History Form
• Explosion Codes

• Integrations
• Payment & Adjustment Types
• Dental Labs
• Referrals
• System Review

Workflow 
Discovery

System 
Setup

Insurance

Clinical

Misc. 
Setup

Project, Clinical, & 
Operations Leads

Project Lead

Project & RCM 
Leads

Project & Clinical 
Lead

Project Lead

WHO SHOULD ATTEND TOPICS COVEREDSESSION
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General Setup
This session will guide you through the foundational setup of your Cloud 9 system. By 
the end of this session, you will have a clear understanding of how to configure and 
manage your practice details, ensuring smooth day-to-day operations.

Purpose

• Establish the core elements required for successful Cloud 9 implementation.
• Ensure all practice and location information is correctly configured.
• Provide a foundation for future setup and training sessions.

Session Topics

• Practice and Location Information
• Employee Setup
• Schedule Views
• Patient Statuses

Preparation Checklist

Practice Information

1. Email Setup:

• Cloud 9 allows email configuration at three levels: Practice, Location, and Employee.
• Employee-level settings override Location and Practice-level settings.
• Please provide the email addresses you plan to use for sending documents.
• Depending on your email host, you may need to generate a new password or provide the 

existing one for Cloud 9 setup. Please have this ready for the meeting.

2. Logo Setup:

• Provide your logo, header, and footer.
• Specify if different locations will use different logos.
• Check-In (Kiosk Station)

o If your practice has a patient check-in station, what message would you like 
displayed during check-in? For example: “Welcome! Please brush your teeth and 
take a seat in the on-deck area. We’ll be with you shortly.”
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General Setup
3. Location Setup

Please have the following information ready for each location:
• Location Name: Internal identifier
• Printed Name: Name that appears on receipts
• Billing & Insurance Information:
• Billing Name or Claims
• Billing Address for Claims
• Provider Number (NPI)
• License Number

• Tax Identification Number (TIN/EIN)

4. Employee Setup

• Review the Employee Permissions document before the session.
• Identify your employee types
• Prepare a list of all employees, including their first and last name, employee type, and 

login name (EX: c9.test)
• During the session, we will add 2–3 employees; the rest can be added afterward.

Provider Insurance Information:

• Provider Number (NPI)
• License Number
• TIN

Optional – Treatment Provider Override:

• Name
• Billing Information Override

5. Schedule Views

• Determine time increments for appointments (e.g., 5, 10, or 15 minutes).
• Prepare the number of chairs and their names/order (e.g., Exam, Consult 1, Consult 2, 

Chair 1, Chair 2, Virtual).

6. Patient Statuses

• Prepare a list of patient statuses and their associated codes and colors.

Homework:

• Complete adding all remaining employees
• Add any remaining schedule views
• Add all remaining patient statuses
• Add all remaining E-Mail Server (SMTP)
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Schedule Setup
Purpose

The objective of this session is to provide clients with a thorough understanding of the scheduling 
functionalities within the Cloud 9 system. This session is designed to ensure that all scheduling 
configurations are established accurately, supporting effective appointment management and 
resource allocation.

Our Implementation Consultants (ICs) will guide you through the setup and customization of the 
scheduling module, including the creation of schedule templates, appointment types, and time 
blocks. By the conclusion of this session, participants will have the knowledge and confidence to 
configure and manage schedules within Cloud 9 successfully.

Session Topics

• Appointment Statuses
• Appointment Types
• Appointment Classes
• Schedule Templates
• Document Editor

Preparation Checklist

To ensure a productive session, please prepare the following information in advance:

• Appointment Types
Provide a list of appointment types with corresponding codes, duration (in minutes), and 
associated colors.

• Appointment Classes (categories for appointment types)
Provide a list of appointment classes with corresponding codes, duration, and colors.

• Schedule Templates
Have available all schedule templates that you intend to use within the Cloud 9 system.

• Document Editor
Prepare a list of letters and documents in Word format that you would like added to Cloud 
Please note that these will need to be entered manually into the system.

Homework

• Add any remaining appointment types
• Add any remaining appointment classes
• Add any remaining schedule templates
• Apply schedule templates to the calendar for the next six months

20



You have access using HTML5 to set up schedule templates and permissions.

Buttons

FIELD DESCRIPTION
Add Schedule Template Create a new schedule template
Edit Schedule Template Modify an existing schedule template
Delete Schedule Template Remove an unwanted existing schedule template
Apply Schedule Template Apply the selected template to the selected

days of the month
Un-Apply Schedule Template Remove any applied template on a selected day(s)
Close Days Indicate the days the office is closed
Close (the window) Close the window

Schedule Setup
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Schedule Template Window

When you click Add or Edit, the Schedule Template window displays. Here you
set up the template.

In the upper left-hand corner, there are Print and Copy buttons:

BUTTON DESCRIPTION

Print
Print the template

Copy
Copy and save the template under 

a different name.

Permissions
Users must have the following permission set to create and manage templates:
Edit > Employees > Add or Edit > Edit Schedule Templates

Schedule Template Options
Before creating your templates, you might want to consider how you want
to search for appointments. There are several ways that you might want
to search:

• Option One – Open Template
• Option Two – Partial Template
• Option Three – Full Template Using Appointment Types
• Option Four – Full Template Using Appointment Classes

Schedule Setup
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Option One – Open Template
This template may look like this example:

Some offices prefer to have their schedule with no specific designated appointment
types. They may want to display only their closed time, leaving the front desk free to
schedule any type of appointment that fits into the open time.

Keep in mind that if you decide to use this type of open template, you will NOT be able
to use the Search feature in scheduling the patient’s next appointment. This also means
that you will not be able to search using the Treatment Card Next Visit section either.
Every appointment needs to be scheduled manually.

Schedule Setup
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Option Two – Partial Template
This template may look like this example:

Some offices prefer to have their day have a partial template and the rest open. For
example, you may only want to create a template for New Patient Exams, Bandings,
and other long appointments, leaving the rest of the schedule open for the front desk
to fill as needed.

Note that if you decide to use this type of open template, you will NOT be able to use
the Search feature in scheduling the patient’s next appointment unless it is an
appointment that has been placed on the template.

In the example above, the search results only showed NE Exam/Adult, NP Exam/Child,
or Band 2 arch appointments. The front desk would have to know which appointment
types are added to the template to search, while all other appointments would need to
be added manually. This also means that you will not be able to search using the
Treatment Card Next Visit section unless scheduling for the templated appointments.

Schedule Setup
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Option Three – Full Template using Appointment Types
This template may look like this example:

Some offices prefer to have their schedules displayed using a comprehensive
template. With this type of template, the day is planned out, with every
appointment type added to the template.

Consider the following if you decide to use this type of template: When using the
Search feature, appointments are only available if the appointment type has not
been scheduled. Busy practices find they can plan their time management easier
with this template. Make sure that ALL appointment types are on the template in
order to use the search feature.

Schedule Setup
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Option Four – Full Template using Appointment Classes
This template may look like this example:

Some offices prefer to have their schedule with a comprehensive template not by
appointment type but by appointment class. Appointment classes are used to group
specific appointment types together. For example, the doctor may not be concerned
with the TYPE of appointment but with the TIME LENGTH of the appointment. Any
appointment that lasts thirty minutes can be scheduled within this timeframe.

Consider the following if you decide to use this type of template: Each class contains
several appointment types. The Exam-30Min class contains the NP Exam/Adult
appointment as well as the NP Exam/Child appointment since they are the same time
length. When using the Search feature, appointments will only be available if the
appointment class has not been scheduled. This template is easier to create as many
appointments belong to one class, rather than templating each appointment type.

NOTE: This type of template works great as long as the practice is a little more flexible
on the scheduling of specific appointment types. Make sure that ALL appointment
classes are on the template in order to use the search feature from the Treatment Card.

Schedule Setup
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Setting up Appointment Classes and Types
and Schedule View

Classes are used to group specific appointment types together. All appointment types
should be the same time length that belongs to a specific class. You can create as many
classes as you need but remember if you have more than 15 classes it might be difficult to
place them all on a single day without constricting the day.

EXAM-30Min (Appointment Class)

• New Patient Exam – Adult (Appointment Type)
• New Patient Exam – Child (Appointment Type)
• Exam – Transfer (Appointment Type)
• Exam – Second Opinion (Appointment Type)

30Min (Appointment Class)

• Adjustment (Appointment Type)
• Impress Appliance (Appointment Type)
• IPR 1 Arch (Appointment Type)
• Seat 1 Appliance (Appointment Type)

Records-30Min (Appointment Class)

• Records Final (Appointment Type)

Consult-30Min (Appointment Class)

• Consultation (Appointment Type)

You can create appointment classes and types from the Edit Menu > Setup >
Appointment Classes > Add or Edit and Edit Menu > Setup > Appointment Types >
Add or Edit.

The schedule view contains options on how a specific schedule is displayed. You create
the start and end times as well as the columns/chairs in this setup. If you open another
office location, here you’ll specify the parameters for each location. You can access this
from the Edit Menu > Setup > Schedule View > Edit or Add.

Schedule Setup
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Create and Apply a Schedule Template

Create a Schedule Template
From the Schedule Template window:

1. Click Add Schedule Template. A blank Schedule Template displays.

2. Click in the Untitled-1 block. The cursor displays.

3. Type in a descriptive name; for example, Monday 9:00 – 2:00.

4. Select a color for the template for easy identification on the schedule’s mini
calendar.

5. Click Save or Close, to save and close the window. The schedule template displays

Set Close Time
From the Schedule Template window:

1. Click on the day(s) to be closed. The day is highlighted.

2. Click Close Days. The day(s) are shaded gray and are marked Closed.

Apply Appointment Class
From the Schedule Template window:

1. Click on the start time of the Appointment Class.

2. Click Reserve Appointment Class item.
The Reserve Appointment Class window opens.

3. In the Appointment Class field, select the class you want to reserve
for the highlighted time.

Schedule Setup

28



4. Select one of the following:

• Reserve Only One should be used when only clicking on one unit for the
start time.

• Reserve As Many As Will Fit should be used when highlighting an area 
that you want several of one type of class reserved.

5. Click Reserve.

Apply Appointment Types
From the Schedule Template window:

1. Click the start time of the Appointment Type.

2. Click Reserve Appointment Type item. The Reserve Appointment Class window opens.

3. In the Appointment Type field, select the class you want to reserve for the highlighted 
time.

4. Select one of the following:
• Reserve Only One should be used when only clicking on one unit for the 

start time.
• Reserve As Many As Will Fit should be used when highlighting an area

that you want several of one type of class reserved.

5. Click Reserve.

Apply a Template

By default, your schedule does not have any templates applied. You want to open each month 
and apply the appropriate template or close the day.

1. From the Edit menu, click Schedule Templates.

2. Click the tab of the location, if necessary. The templates that have been created for this 
location are displayed.

3. Click on the days of the month that the office is closed.

4. Click Close Days. The days selected are now indicted as closed.

5. Click the days of the month to apply a specific template to.

6. Click on the template name listed on the left. The name highlights.

Schedule Setup
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7. Click Apply. The days turn the color of the template
and display the name.

8. Continue this method and complete the month.

9. Click OK when finished. The mini calendar on the schedule displays the color
of the template applied to that day.

Copy a Template

Rather than starting from a blank template, you might have one that you want to start with
and then make slight modifications. For example, every Wednesday you want to add more
New Patient Exams for the summer months. Your template is only used for the summer
months, so you do not want to change the regular Wednesday template. Making a copy of
the regular Wednesday template, giving a descriptive name and making your changes
creates a new one with minimal effort.

1. From the Edit menu, click Schedule Templates.

2. Select the desired schedule.

3. Highlight the name of the template to be copied.

4. Click Edit.

5. Click Copy to duplicate the template.

6. Type a descriptive name and click OK.

7. Modify the template as desired.

8. Click Save and Close to have changes applied. The new template has been
created and ready to apply to the summer months.

Modify a Schedule Template
Every template now and then needs modifying. We give you the choice of modifying a
template that has been applied for just that specific day or changing the template that
changes all future days the template is applied to. An example of changing just one day
might be the need to extend a lunch break because of a presentation to the office. This
would only affect one day, not any other day in the future. A change to every day in the future 
might be that you are changing the open and close times or simply the need to add a few
more specific appointments to your schedule for a specific day of the week.

Schedule Setup
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Modify a Single Day

When you modify a single day in the schedule, you do not need to edit the template master. 
These changes are done directly on the day in the schedule and will not change any other day 
in the future.

1. Open the Calendar to the day that needs changing. In this example, the lunch break 
is going to be extended by 30 minutes.

2. Highlight the range that needs to be closed.

3. Click Close Time item. The additional time is closed. You can now correct any other 
appointment class/type in order to fill in time. In Chair 1, a 45-minute block of 

time was reserved. You might want to add a 15-minute appointment in its place.

4. Click the class/type to be corrected, select Reserve Appointment Class/Type and 
select a 15-minute slot. The template may look similar to this.

Clear Overrides

If you found that you changed an incorrect day and need to have the template back to 
its original format. This is an easy process.

1. Highlight the times that were modified.

2. Click Clear Overrides item. The template reverts back to the original times.

Modify a Template to Change All Future Days Applied

When changing a template master, all future days the template is applied to are changed. 
Be very careful how you use this template.

1. From the Edit menu, click Edit Templates icon.

2. Select the correct schedule, if applicable.

3. Highlight the name of the template to be corrected, click Edit icon.

4. Click on the Appointment Class/Type that needs to be changed.

5. Select the appropriate item from the list. Continue to change the template as desired.

6. Click Save and Close to have changes applied.

Schedule Setup
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Delete a Template

If you have unused templates, you may choose to remove them from the list so that no one 
accidently applies it. Be careful, if the template was applied to a future day and is deleted, the 
day no longer has a template applied. You need to apply a template to that day.

1. From the Edit menu, click Edit Templates icon.

2. Select the correct schedule, if applicable.

3. Highlight the name of the template to be removed, click Delete icon.

4. Click OK to acknowledge the action.

5. Click OK to close the Schedule Template window.

Schedule Setup
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Clinical Setup
Purpose

The purpose of this session is to ensure that all clinical functionalities within the Cloud 9 
system are properly configured and tailored to meet your practice’s needs. This session is 
designed to provide a comprehensive understanding of the clinical tools and features 
available, supporting efficient patient care and streamlined clinical operations.

Our Implementation Consultants (ICs) will guide you through the setup and customization 
of the clinical modules, including treatment card configurations, treatment plans, clinical 
questionnaires, and imaging setups.

Session Topics

• Treatment Card Configuration
• Treatment Plans
• Clinical Questionnaires
• Imaging

Treatment Card Configuration

• Doctor
• Assistant
• Upper Arch
• Lower Arch
• Elastics Right
• Elastics Left

• Oral Hygiene
• Cooperation
• Appliances
• Broken Bracket
• Procedure
• Next Visit Appointment

Each column represents potential selections available during an appointment.
Action Required: Please prepare a proposed layout and list of items for each column. 
For example:

• Upper Arch (UA): .0175 twist, 012 niti, 014 niti, 014 ss, 016 TMA, 016 niti, 016 ss, 018 ss, 
16x16 cn, 16x16 niti, etc.
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Clinical Setup

Treatment Plans

• Cloud 9 offers three methods for creating treatment plans:

• Step-by-Step Treatment Plan – A detailed plan created in sequential steps.

• Treatment Plan Notes (Best Practice) – Paragraph-style notes that can be generated 
from questionnaires.

• Manual Entry – Free-form text entry.

Action Required:
If you prefer to set up a step-by-step treatment plan, please come prepared with:

• The treatment plan name.

• Each step included.

• The number of weeks between steps.
(Example: “Bond U 6-6” scheduled four weeks from the previous step.)

If you prefer the treatment plan notes from the questionnaire, please come prepared with:

• The questions you want included on your treatment plan

Clinical Questionnaires

We will review the New Patient Exam Questionnaire during this session.

Action Required: Please identify any items you would like to add, remove, or 
customize before this session.
Imaging

Action Required: Please confirm the order in which patient photographs should be taken 
to ensure proper imaging setup in Cloud 9.

• Include a list of the type of images you take in the office (EX: Pano, Ceph, etc)

Homework

• Add remaining items to the treatment card 
(UA, LA, EL-R, EL-L, OH, CO, APPL, TX NOTES)

• Add remaining treatment plans if using the step-by-step option
• Finish editing the new patient exam questionnaire with items you want 

to add or remove
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Cloud 9 Letters

Letter Name Keep & Update Delete

C9O-Welcome Letter-Adult

C9O-Welcome Letter-Child

C9O-8 Image Collage with Pan

C9O-Blank Letterhead

C9O-Contract

C9O-Contract with AutoPay Auth

C9O-Debond Certificate

C9O-Early Debond Release

C9O-Extraction Request

C9O-Insurance Terminated

C9O-NP Exam Letter-Detailed-DR

C9O-NP Exam Letter-Detailed-PT

C9O-NP Forms-Adult

C9O-NP Forms-Child

C9O-Treatment Request

C9O-Poor OH Letter

C9O-Debond Certificate

C9O-Debond Letter-Patient

C9O-Past Due 30 days

C9O-Past Due 60 days

C9O-Past Due 90 days

C9O-Payment Options

C9O-Poor OH Letter

C9O-Treatment Request

C9O-Financial Arrangement

In Cloud 9, a “Document” is a template used to generate letters by reusing standard 
content with merge fields for customization.

All templates are created in the built-in Document Editor; therefore, no external word-
processing software is needed. All correspondence is managed directly within Cloud 9.

Your Cloud 9 Software includes the following standard letters. If you have your own 
versions, we can guide through how you can import, update, and format them. Please 
review the list and note any changes or deletions you’d like to make.
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Financial Setup
Purpose

The purpose of this session is to ensure that all financial settings, patient portal 
configurations, and outstanding homework tasks from prior sessions are accurately 
reviewed and completed. This session provides a comprehensive overview of the financial 
functionalities and patient portal features within the Cloud 9 system, ensuring that all 
configurations are properly established to support your practice’s operations.

Our Implementation Consultants (ICs) will guide you through the setup and customization 
of financial settings, including payment processors, fee schedules, and insurance 
configurations.

Session Topics

• Transaction Types
• Contracts
• Financial Arrangements (optional feature)
• Fee Schedules (optional feature)
• Patient Portal (optional feature)

Transaction Types
Accurate configuration of transaction types is critical to ensuring reliable financial 
reporting and operational efficiency within Cloud 9.

Action Required:
Please provide a complete list of the transaction types that your practice will use in Cloud 
9. For each transaction type, include the following details:

• Description
• Code
• Amount
• Color (font color in ledger)

• Whether it affects production
• Whether it should appear on the Practice 

Summary Report
• CDT Code (if applicable)
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Financial Setup

Financial Arrangements (Optional)

If your practice contracts with insurance companies and uses fee schedules, 
the Financial Arrangements feature can significantly reduce administrative work. This 
feature pulls fee schedules directly into financial arrangements and auto-populates them 
into contracts/proposals.

Action Required:
If you wish to use this feature, please prepare the following in advance:

• The types of arrangements you plan to offer (e.g., Invisalign, braces, high plans, low 
plans).

• Default down payment amounts.

• Max Number of Payments allowed.

Fee Schedules (Optional)

• If your practice uses fee schedules (UCR, PPO, HMO), please confirm the details of 
each schedule to ensure they are set up accurately within Cloud 9.

Patient Portal (Optional)

• Include what appointment types you want featured on patient portal

• Include if you want to allow Online Payments through the patient portal

Homework

• Add remaining transaction types
• Add remaining financial arrangements
• Add remaining fee schedules
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Transaction Types

For this setup item, please provide a complete list of all charge types, payment types, 
and discount types your office plans to use.

Cloud 9 will supply a standard set of transaction types for your selection; however, if your 
office utilizes any additional transaction types, please include those as well.

For each transaction type, indicate how it will be used within the system and specify 
whether it should be included or excluded from reports.

• Contract Charges are set as Medium Orchid
• One-Time Charges are set as Red
• Payments are set as Green
• Adjustments and Discounts are set as Blue (Colors can be edited)
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Below is a list of available options to select when creating a transaction type, along with 
their corresponding definitions.
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Transaction Types

Show in Treatment Card Check when the charge is a procedure to display on the patient’s treatment card

Show on Deposit Report 
(Payment)

Check this to show on deposit report. This is not used for credit cards and ACH items.

Is Paid-In-Full Discount 
(Adjustment)

Check this item when creating a PIF discount. This will make it selectable when creating 
contracts.

Affects Production 
(Charge Type)

Check when the transaction should be considered a production item

Is Contract (Charge) Should this transaction type be selectable when creating contracts? This item is checked 
when adding treatment fees

Show on Practice Summary Check this to include this transaction type in the Practice Summary Report

Show on Adjustment Report 
(Adjustment)

Check when the transaction should appear on the adjustment report

Is Late Fee (Charge) Check when the transaction is considered a late fee. Works correspondingly with the late 
fee queue.

Is Courtesy Discount 
(Adjustment)

Check this item when creating a courtesy discount. This should be selectable when 
creating contracts.

Is Credit Card (Payment) Check when the office is integrated with Planet DDS Pay, Open Edge or FIS for credit 
card payment processing

Is Discount (Adjustment) Check this item when creating discounts. This should be selectable when creating 
contracts.

Is Insurance Check to indicate bulk insurance payments and bulk insurance adjustments. Not for one 
off insurance payments.

Is No Show Fee (Charge) Check when the transaction is a no show fee. This works correspondingly to marking 
patients as a No Show

Is Optional for FA Transactions marked as “Is Optional for FA” are imported into Financial Arrangements 
as “Optional” only if they were selected in the Questionnaire completed before the 
Financial Arrangement was created.

Treat As Ortho? (Charge) Check when using this transaction type as part of a Fee Schedule

Is Payment Arrangement Check when tracking the Payment Arrangement type. Not used for actual payments, but 
when creating a contract, the user is able to select the Payment Arrangement for 
reporting purposes.

Is Origin of Start (Charge) Check when tracking the Start of a Contract. Not used for actual charges, but when 
creating a contract, the user is able to select the Origin of Start for reporting purposes.

Show on Route Sheet Check this to include the transaction type on the Route Sheet

Is NSF Fee (Charge) Check when the transaction type is charged when an ACH payment is returned. 
This works correspondingly with Scheduled Contract Payments or can be used as 
a one-time charge



Charges:

Charges used for Contracts (i.e., Comprehensive Adult Treatment) will need to be marked “Is 
Contract”.

If the amount for charges change across locations or on a per-case basis, leave it at $0.00. When 
posting the contract charge or one-time charge, the user can enter in a custom amount.

Listed below are the Charge Types provided in Cloud 9 (Contracts are in Medium Orchid / One-
Time Charges are in Red)
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Transaction Types

Description Keep, Delete or Change? (Add any details)

Aligner Adult Treatment

Aligner Limited Treatment

Aligner Teen Treatment

Comprehensive Adolescent Treatment

Comprehensive Adult Treatment

Comprehensive Child Treatment

Limited Adolescent Treatment

Limited Adult Treatment

Medicaid Comprehensive Treatment

Medicaid Phase I Treatment

Phase I Treatment

Phase II Treatment

Appliance Charge – Fixed

Appliance Charge – Removeable

Appliance Repair Charge

Broken Bracket Charge

Insufficient Funds Charge

Late Fee

No-Show Fee

Office Visit Charge

Records Charge

Retainer Repair Charge

Retainer Replacement Charge



Please list additional charge types you would like to add in the table below:
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Payments: 

Typical Payment types are Check, Cash and Credit Card. Marking “Is Insurance” will work 
correspondingly with the Insurance Bulk Payment feature in Cloud 9 

Listed below are the Payment Types provided in Cloud 9: 
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Transaction Types

Description Keep, Delete or Change? (Add any details)

Cash Payment

Check Payment

Credit Card Payment

Insurance Check Payment

Insurance Credit Card Payment

Insurance EFT Payment

Insurance Payment Bulk Check

Insurance Payment Bulk Credit Card

Insurance Payment Bulk EFT

Money Order / Travelers Check

Third Party Financing (Care Credit)

Please list additional payment types you would like to add in the table below:

Description Code
Show on 
Deposit 
Report

Is Credit 
Card

Show on 
Practice 
Summary

Is 
Insurance 
(Bulk)

Show on 
Route 
Sheet

Insurance 
Check

PMT-
INSCK Yes No Yes No No



Adjustments: 

Adjustments are used to move money around or on/off a patient’s ledger. The standard 
Adjustments provided to you by Cloud 9 cannot be deleted but the Description can be 
renamed. Additional Adjustments can be added as well. 

Below is a list of Adjustment Types provided to you by Cloud 9:
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Transaction Types

Description How is it Used? Rename Description?

Balance Adjustment Moving money between Receivables 
and Future Due

Refund Balance is added back to ledger after refunding 
patient. Typically followed by a Write-Off

Transfer Transfer credit or balance between ledgers

Write-Off Removing balance from ledger

Write-Off - Collections Removing balance from ledger

Write-Off – Discontinuation 
of Treatment

Removing balance from ledger

Write-Off - Insurance Removing balance from ledger

Write-Off – Transfer 
Out of Practice

Removing balance from ledger

Please list additional adjustment types you would like to add in the table below:

Description Code
Affects 

Production

Show on 
Adjustment 

Report

Show on 
Practice 

Summary

Is Insurance 
(Bulk)

Show on 
Route 
Sheet

Write-Off WO Yes No Yes No No



Discounts: 

Discounts are applied when creating a contract only and will always affect production. 
Discounts can also have a set amount assigned to it or leave it at $0.00 to customize at the 
time the contract is being created. 

Below is a list of Discount Adjustment Types provided to you by Cloud 9:
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Transaction Types

Description Keep, Delete, or Change?

Courtesy Discount

Employee Discount

Family Discount

In-Network Discount

Paid in Full Discount

Phase I Discount

Professional Discount

Please list additional discounts you would like to add in the table below:

Description Code
Affects 

Production

Show on 
Adjustment 

Report

Show on 
Practice 

Summary

Is Insurance 
(Bulk)

Show on 
Route 
Sheet

Insurance 
Check

PMT-
INSCK

Yes No Yes No No



Financial Arrangements Setup
Financial Arrangement Types

You can create different financial arrangement types based on treatment plans (e.g., 
Invisalign, Braces, Comprehensive). Examples include High Plans, Low Plans, or a single 
standardized option for the entire practice.

These arrangement types specify the payment options available to each patient, 
simplifying the process for both the practice and the patient.

Examples of arrangement types include High Plans, Low Plans, or a single option for the 
entire practice.

• Description: A unique name or identifier for the financial arrangement type.

• Default Down Payment: Set a default down payment that applies across the practice.

• Low Down Payment: Define the lowest allowed down payment for patients.

• High Payment Number: Establish a limit on the number of installments a patient can 
make, preventing excessively long payment plans that reduce monthly charges.

• Until Contract Start: When the first charge is set to roll out.

• Max Days Until Signature: Number of days allowed to sign a financial arrangement 
before an error is given. This cannot be bypassed.

Edit Financial Arrangement Types
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Financial Arrangements Setup

Description Default Down 
Payment

Low Down 
Payment

High Payment 
Number

Until 
Contract 

Start

Max Days 
Until 

Signature

Default $500 $350 30 30 90

A Financial Arrangement (FA) document can be attached to any of these financial 
arrangement types to default. Cloud 9 provides a standard Financial Arrangement 
document under Home > Document Editor. Customers can make a copy by selecting 
"Save As" and make any changes necessary to the verbiage.

Fee Schedule Types

When creating your fee 
schedules, you must select the 
type of fee schedule this is.

You will need a UCR and 
typically PPO and HMO. PPO and 
HMO should be selected to 
Default to UCR if that specific 
insurance fee schedule item 
does not have a contracted rate.
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Financial Arrangements Setup

Transaction Types

To ensure the specific transaction types apply to fee schedules, the team must add a few 
additional items to the Transaction Type setup:

• Ensure the CDT Code is also on 
the Transaction Type Tab in 
EDIT (Not only in Transaction 
Codes tab)

• Mark "Treat as Ortho" for the 
Plan Amount in the FA to pull 
from the patient's benefits tab.

• Example for correct setup is 
pictured to the right:

Fee Schedules: Edit > Setup > Fee Schedule

Set up UCR up first!

1. Name: Ex: Practice UCR / Location UCR
2. Type: UCR
3. Make sure you have your list of charges and how much they are
4. Click ADD+ all

CONTRACTED INSURANCES

1. Add
2. Name: Insurance Ex: BCBS
3. Type: PPO

• bring in one transaction type at a time / + with circle around it is to bring in all 
fee schedule transaction types at once
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Financial Arrangements Setup

Practice/Location UCR

For the correct UCR fees to pull onto the Financial Arrangement, you have to attach the 
UCR to the office location.

If the office has multiple locations, but uses the SAME UCR fees for all the locations:

• Edit > Practice Information
• Under the Insurance tab, attach the UCR under Fee Schedule
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Financial Arrangements Setup

If there are different UCR fees per location, the UCR fee schedule needs to be added to 
the Location Setup

• Edit > Setup > Locations
• Under the Insurance tab, attach the UCR under Fee Schedule
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C9 Agent Installation
C9 Agent is used for connecting printers, X-ray machines, document scanners, and 
Topaz signature pads to Cloud 9. This is completed via an installation on a computer 
running Windows 8.1 or later.

NOTE: C9 Agent is not available for Mac users.

Printers connected to the PC running C9 Agent can be used to print from anywhere while 
logged into Cloud9. Not every screen supports this type of printing, and normal printing 
can also be used for any of these situations. Offices may have numerous virtual printers 
and may also specify defaults per individual or on a site-wide basis.

X-ray machines connect to C9 Agent to upload images directly into Cloud9 under Home > 
Images. When an X-ray is taken, a copy is stored in the 
user's document/twainexport folder on that PC until another X-ray is taken.

Document Scanners connect to C9 Agent to upload documents directly into Cloud9 
under Home > Document Cabinet. Documents have a 10 MB limit.

Topaz Signature Pads connect to C9 agent and are used for signature-based functions 
when merging letters in Cloud 9.

Installation

1. In Cloud 9, go to Help > Download C9 Agent
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C9 Agent Installation

2. Follow installation prompts.
3. Register C9 Agent.

a. The Agent Name is just a name for this agent. 
b. Cloud9 URL will be https://sitename.cloud9ortho.com/

(no "html5" at the end).
c. User and Password can be any user on this practice’s URL.

4. Once C9 Agent is connected, it will look like this.

Setup Scanners and X-Ray
1. Select Twain Device and hit OK (not cancel).

a. TWAIN Device – use this for scanners only.
b. Ceph Device – use this for Cephalometric/Ceph X-Ray machines or for taking 

image series.
c. Pan Device – use this for Panoramic X-Ray machines.

2. Allow 1 – 2 minutes for the agent to appear in Cloud 9.
3. Go to Home > Images or Home > Document Cabinet in Cloud 9. 
4. In Images – Acquire a pan, ceph, series
5. In Document Cabinet – Acquire a document.
6. Select the name of the C9 Agent that is connected to the device you are trying to use.
7. The scanner or X-Ray console/window will pop-up if successful.
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CONVERSION

Bringing Your Data Over

To complete your onboarding successfully, we’ll 
also focus on your data conversion. This ensures 
that your existing information is carried over 
accurately and securely into Cloud 9. We will:

• Review the overall conversion policy.

• Walk through the trial data conversion process to 
preview how your data will appear.

• Proceed to the final data conversion.

• Follow with imaging and scanned document 
conversions.

These steps ensure your practice starts with a 
complete and reliable system.



Conversion Policy
Embarking on a conversion from your legacy PM system to Planet DDS Denticon or Cloud 
9 software is an exciting journey towards enhanced efficiency and modernized operations. 
To ensure a smooth transition, it's crucial to adhere to our policies regarding data 
extraction, cancellation, and rescheduling of appointments. Following these guidelines will help 
avoid unnecessary delays and additional costs, enabling you to successfully 
implement your new software.

Every customer’s data is different and has evolved over time. We need your data to set 
realistic goals and timelines, your Implementation Coordinator will be instrumental to you 
in defining and committing to due dates. Data received late from your existing PMS vendor 
may delay the go-live date, so proper planning and communication is essential.

Communication 

Denticon customers should include implementation@planetdds.com on any 
communication regarding your data extracts (trial extract, final extract, or your final data 
upload) so a representative from the implementation team can assist you. 

Cloud 9 customers should include cloud9implementations@planetdds.com on any 
communication regarding your data extracts (trial extract, final extract, or your final data 
upload) so a representative from the implementation team can assist you. 

Please don’t hesitate to reach out throughout your implementation if you have any 
questions or concerns. 

Data Extract Late Policy

Clients who do not connect the Planet DDS team or provide required data more than 20 
minutes after the data capture appointment will be charged a $175 fee and will be required 
to reschedule the capture time.

Any rescheduled data captures will be scheduled based on current availability which could 
impact your selected go live. 

Cancelling or Rescheduling Final

Rescheduling or cancellations must be submitted in writing. If notice is provided less than 
14 business days before the go-live date, a one-time fee of $1,000 per conversion will 
be applied.

Rescheduled data captures will be arranged based on current availability. Clients unable to 
provide final data by the scheduled data pull date will incur the specified surcharges.
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Conversion Policy

Cancelling or Rescheduling Trial

Rescheduling or cancelations of a Trial Data Extract less than 24 hours prior to the scheduled 
appointment will result in a one-time $175 fee per location. 

Rescheduling or cancelations of a Trial Data Conversion after conversion is in process will 
be charged a one-time $175 fee per location. 

Deadline to Add Extracts to Calendar

To minimize disruption to clients and allow our conversion team time to plan appropriate 
resources to ensure the best conversion results, the data conversion schedule locks every 
Thursday at 11:59pm PT for the following week; this means we will not add new 
conversions to the calendar for the following week beyond the mentioned deadline.

Data Conversion Timing

Our standard conversion timeline is 7-9 weeks. 

Our standard conversion checklists specify the data points that are converted for each 
Practice Management System. Any data points not included in the standard checklist will 
require custom programming. Please note that not all custom programming requests can 
be fulfilled, as they depend on the availability and integrity of data from the source system.

Custom programming requests will be assessed by our Conversion team, who will provide 
an estimate of the applicable fees to research and program and an adjusted timeline for 
the go-live date.

Blackout Periods

Below is a list of Federal Holidays Planet DDS observes where we do not process 
conversions or complete data extracts. Your assigned implementation coordinator can give 
you specific closure dates based on the current calendar year. 

• Memorial Day
• Independence Day
• Labor Day
• Veteran’s Day
• Thanksgiving Day
• Christmas Day
• New Year’s Day
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Data Validation Guidelines

One of the most important aspects of your 
transition to Cloud 9 is the process of validating 
the integrity of the data converted from 
your legacy practice management system 
into Cloud 9.

Attached you will find a copy of the audit form that 
you are to complete and return to us by the 
established deadline provided by your 
Implementation Coordinator.

In addition, you will be provided with the conversion 
checklist from your legacy practice management 
system that will outline all the items that are 
included as part of the standard conversion from 
that system.

Should you identify discrepancies during the audit, 
you must provide screenshots from your legacy 
practice management system so that our team can 
research. Please make sure that your document 
includes the patient’s name, date of birth, and 
outlines in detail what is missing that should have 
been included based on the conversion checklist 
provided.

Please note that audit findings will result in a reload 
of the data once the issues are identified and 
resolved; you will be notified that the fix has been 
deployed and asked to review the data again to 
confirm the change made meets expectations.

Thank you in advance for your time and efforts to 
ensure that your converted data is reflected 
correctly in Cloud 9.

Should you have any questions about the 
auditing process, please contact your 
Implementation Coordinator for clarification.

Because we want to ensure 
that the audit process is 
comprehensive, we are 

asking you to audit a 
minimum of 15 patients 
and are providing patient 

guidance below on the types 
of patient records to 

include in your review.

• Patients with varying 
statuses (e.g., active, 
observation, retention)

• Patients with insurance 
coverage

• Patients with multiple 
relationships

• Patients with active 
contracts

• Patients with current 
and/or past due balances

• Patients with documented 
referral sources

• Patients with past and 
future appointments
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Understanding Token Transfers

What Is a Token Transfer?
Token transfer is the process of securely moving stored payment tokens from your current 
payment processor to a new one when you switch services. A payment token is a 
substitute value for your customer’s real card number, used for transactions like recurring 
payments or card-on-file purchases. Instead of storing the actual card number, your 
processor keeps a unique token that represents the card and maintains the secure link 
between that token and the original card details.

Because each payment processor creates and manages its own tokens in a proprietary 
way, the tokens from your old processor typically can’t be used directly by the new 
provider. The mapping between the token and the card number exists only in the original 
processor’s system, making it impossible for the new processor to interpret them.

To migrate tokens, special steps are needed:

• The old processor “detokenizes” the card internally and securely sends encrypted 
card data to the new processor.

• The new processor then creates new tokens (“retokenizes”) for those cards in 
its system.

• Throughout this process, merchants never handle the raw card data. This helps 
ensure a seamless transition for recurring billing and card-on-file transactions, 
minimizing disruption for your customers.

If a direct token migration (sometimes called “retokenization”) isn’t possible—because 
the processors don’t have a token exchange program—customers will need to re-enter 
their payment details so new tokens can be created by the new processor.

Important Notes
• Planet DDS does not guarantee the ability to complete token transfers.

• Token transfers are best-effort; success depends on file quality and 
mapping accuracy.

• Delays may occur due to third-party processors. Planet DDS provides guidance and 
support but cannot control external timelines.

• Do not cancel your legacy payment processor immediately. This ensures you can 
continue processing payments while the migration is underway and prevents any 
interruption in service for your customers.

• Migration fees may apply from your legacy payment processor.
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Token Transfer Overview 

•Unique patient 
identifier 

•Patient token 
data 

Previous PMS

•Unique patient 
identifier 

•Patient token 
data – Sends 
PAN data 

Previous Processor

•Unique patient 
identifier 

•Receives PAN 
data – creates 
new tokens

Planet DDS Pay 

•Unique patient 
identifier 

•Receives new 
tokens

Planet DDS 

Payment tokens are unique, secure identifiers that replace card numbers 
in Cloud 9, ensuring payment security and privacy.

Credit Card Number or PAN: 4111 1111 1111 1111
Payment Token: TKN-8F2A9E374G6H

The process of moving tokens can take four to six weeks.

Migrating Contracts, Recurring Payments, & Cards on File from the 
Previous Payment Provider

Note: The exact process may vary based on your legacy processor. We will review your 
specific case during the onboarding process.

• Step 1: Request token file from your current processor. Ensure token file includes 
patient identifiers, encryption details, and file specs.

• Step 2: Planet DDS initiates token migration.

• Step 3: Migration takes 4–6 weeks.
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Learning and Adoption

Our Cloud 9 training program offers a flexible blend 
of self-paced eLearnings and immersive virtual 
sessions designed to support users at every stage 
of adoption.

Learners gain hands-on experience with core 
workflows in a collaborative environment, while 
post-training resources and support ensure 
continued success beyond the classroom.



Cloud 9 Learning Program
Overview

Our training program is designed to give your team confidence from day one. Through self-
paced eLearning, guided live sessions, and ongoing support, you’ll have the tools and 
resources needed to learn and succeed. This program builds a strong foundation, provides 
hands-on practice, and ensures your team is ready to apply knowledge with confidence.

Step 1: Self-Paced Learning in Cloud 9 Learning Center

• Access comprehensive eLearning courses for all users.
• Includes interactive, click-through tutorials for hands-on workflow practice.
• Covers foundational concepts to prepare your team for live sessions. 
• Available on-demand for flexibility and convenience.

Step 2: Guided Training Sessions

• Attend live learning sessions tailored to your training package (e.g., front office, clinical).
• Focuses on reinforcing Learning Center concepts and providing real-time practice.
• Structured agenda to ensure consistency across teams.

Step 3: Ongoing Support

• Access the Cloud 9 Help Portal for articles, videos, and searchable “how-to” content. 
Continuous updates and quick answers help reinforce learning and keep teams 
confident.

• Attend our live Q&A sessions as needed for additional support.

Access the Live Learning 
Session Schedule here!
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Logging into Cloud 9 Learning Center

1. Go to 
planetdds.learnupon.com

2. Click “Register now.” 

3. Enter your email address associated with your Cloud 9 
account and create a password. Click “Register”.

4. You will be sent a confirmation email from 
LearnUpon. Click on the blue hyperlink. 

5. Enter your office’s 
Cloud 9 URL, your 
work email, and 
Organization Name.
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Go Live Preparation

As we move closer to go-live, preparation is key 
to making the transition smooth and successful. 
We’ll start by:

• Covering gap data management to ensure all 
remaining information is captured and 
organized.

• Reviewing best practices to help your team 
prepare for day one.

• Sharing available resources to support and 
guide you and your team throughout the 
process.



Deliverables Acceptance Criteria Confirmed

System Setup
The system is fully set up, and no pending actions or
decisions are required.

Trial Conversion Audit
Client was provided with the Audit Guide and reviewed at
least 15 patients in detail.

LMS Completion
End users have completed their designated classes and/or
learning paths in the Planet DDS Learning Management 
System.

Office Setup

Office is ready for training and go-live. All users have
successfully logged in and all computers have successfully
accessed the application. Local agents have been installed 
as needed.

Payment Processing
(If Applicable)

The system is ready to process payments. Any needed
security/token files have been exchanged and accepted. 
Credentials have been entered. Hardware (if applicable)
has arrived and been tested.

Training Preparation

Office areas have been identified for classroom style and
independent hands-on learning. Staff are scheduled for 
appropriate sessions. The office will be closed during 
training sessions, with reduced patient load for Go Live, as 
agreed with the Planet DDS trainer.

Customer Sign-Off Form
Practice Name:

Client Project Lead:

Implementation Coordinator:

Implementation Live Date:

Instructions: Review each deliverable and confirm work is completed. If all issues are
closed or if open issues exist but a satisfactory plan to address them is in place, mark Yes
under Confirmed. If you are not prepared to take the system live and there are outstanding
concerns without a satisfactory plan to resolve, mark No. Document any gaps or issues and 
the plan to resolve in the Open Issues section below.
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Open Issues with Corresponding Closeout Plans and Additional Comments:

Client Representative:

By signing below, the Client acknowledges that the setup, software implementation, and trial
data conversion have been completed to their satisfaction and meet the agreed-upon
acceptance criteria. The Client is ready to go live.

Printed Name:

Title:

Date:

Signature:

Customer Sign-Off Form
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Cloud 9 Data Clean-Up & Merge Utilities
Purpose

This document outlines best practices and expectations for managing Cloud 9 data clean-
up and merge utilities. These practices are designed to ensure data accuracy, reduce risk, 
and drive successful project completion through clear ownership, client collaboration, 
and controlled system access.

Implementation Coordinator Responsibilities

Overall Ownership Client Partnership & 
Collaboration Provide Client Action Items

• Lead, initiate, and manage 
all data clean-up and data 
merge utilities.

• Ensure all activities follow 
internal best practices and 
established processes.

Work closely with the Client 
Project Lead to:

• Confirm scope, expectations, 
and timelines.

• Validate decisions and ensure 
clarity on required action items.

• Request client input for merge 
decisions where business 
judgment is needed.

Deliver a clear, itemized list of 
client-required clean-up tasks, 
such as:
• Insurance companies
• Insurance billing centers
• Postal codes
• Practice-specific reference data

Offer clarification or guidance as 
needed.

Documentation & Training Security & Access Control Communication & Risk 
Management

• Document all data mapping 
and clean-up decisions.

• Provide training or 
explanations to support 
client understanding and 
usage of Cloud 9 tools.

• Ensure "Run Utilities" 
permission is never enabled 
for customer users unless 
explicitly required and 
approved.

• Confirm that the permission is 
removed once all cleanup and 
merge utilities have been 
completed.

• Proactively communicate 
expectations throughout the 
project.

• Identify, document, and 
escalate risks or client-
readiness concerns using the 
R&I process.

• Validate that all clean-up and 
merge activities are complete 
before moving the project to 
final completion.



Client Responsibilities

Participation & 
Collaboration

Readiness & 
Accountability Decision-Making Input Security & Access 

Adherence

• Designate a Client 
Project Lead to 
partner with the IC.

• Provide timely 
responses, 
decisions, and 
clarifications when 
requested.

• Complete assigned 
tasks within agreed-
upon timeframes.

• Report internal delays, 
issues, or concerns 
that may impact 
implementation.

• Ensure internal staff 
understand 
requirements, 
deliverables, and 
timelines.

• Provide necessary 
business insights to 
support accurate merge 
and data-mapping 
decisions.

• Review materials 
shared by the IC and 
approve or request 
adjustments as needed.

• Do not enable or assign 
the "Run Utilities" 
permission to any staff.

• Follow all access 
control guidance 
provided by the IC.

Client-Owned Clean-Up Tasks

The client is responsible for completing the clean-up items assigned by the Implementation Coordinator, which 
may include:

• Reviewing and correcting insurance companies
• Validating insurance billing centers
• Confirming postal codes
• Updating practice-specific reference data
• Completing any additional clean-up items identified during the project

Category Implementation Coordinator Client

Ownership of Clean-up & 
Merge Utilities-Up & Merge 
Utilities

Leads, manages, and executes all 
utilities

Supports with required information

Data Clean-up-Up
Identifies required clean-up and 
provides task list-up and provides task 
list

Completes assigned clean-up items-up 
items

Merging Decisions
Provides recommendations and 
performs merges

Provides business context and 
approvals

Documentation & Training
Documents all decisions and provides 
training

Reviews documentation and applies 
training

Security Controls “Run Utilities” permission Follows permission guidance

Risk & Communication
Escalates via R&I, proactively 
communicates

Raises internal risks and collaborates

Summary Table

Cloud 9 Data Clean-Up & Merge Utilities



We’re Upgrading for You! 
This office is transitioning to Cloud 9

a modern, cloud-based system from Planet DDS.

Why the Change?
Cloud 9 helps us deliver faster, smarter, and more personalized care — 

all while streamlining our work behind the scenes.

What This Means for You
You may notice a few extra steps or brief delays as our team gets familiar with 

the new system. We appreciate your patience and support as we make this 
exciting upgrade!

Better Systems. Better Care.
We’re committed to making your experience even better — 

and Cloud 9 helps us do just that.

Thank you for bearing with us during this transition.
We’re excited about what’s ahead — 

and grateful to have you with us!

Powered by
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Live on Cloud 9!

As we wrap up onboarding, our goal is to make 
sure you feel fully supported as you transition 
into ongoing use of Cloud 9. We’ll start by:

• Providing access to the New Client Guide, 
highlighting key information and resources at 
your fingertips.

• Overviewing our 30-day post live 
implementation support model.

• Reviewing the handoff process to our Support 
and Account Management teams, so you know 
exactly where to go for help and guidance.

Together, these steps help set you up for 
long-term success.



This certifies that

Your Dental Office
has 

SUCCESSFULLY COMPLETED

IMPLEMENTATION
of Planet DDS software

Date



Post Go Live Support: What to Expect

As you go live with our products, we want to ensure your transition is smooth, successful, 
and fully supported. That’s why your Implementation Coordinator will continue to work 
closely with you for 30 days after go live to finalize all implementation activities.

Continued Support from Your Implementation Coordinator

For the first 30 days post go live, your Implementation Coordinator will:

• Address any outstanding setup or configuration needs
• Ensure all implementation tasks are fully wrapped up
• This dedicated support period is designed to give you confidence and continuity as you 

begin using our products in a live environment.

Transition to Post Live Support

• After the 30-day wrap-up period:
• You’ll transition to our Post Live Support Model, which includes:

→ Access to our expert Support Team
→ Self-service resources and knowledge base
→ Ongoing customer success check-ins (if applicable)

We’re here to support you every 
step of the way—from onboarding 
to long-term success!
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Cloud 9 Support Overview

When Should I Contact Cloud 9 Support?

Contact Cloud 9 support for any of the following reasons listed below.  

Issue Type Details

Technical Issues Problems with software you cannot resolve on your own.

Product Questions “How to” questions about features or processes.

Billing Questions Questions about invoices or billing.

Service Interruptions Outage or partial loss of service affecting product use.

Feedback Suggestions or feedback about features or functionality.

Additional Training Additional remote or on-site training needs.

Data Needs Questions regarding how to access or obtain data.
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Cloud 9 Support Overview

Ticket Priority & Definitions

Best Practices for Submitting a Ticket:

• Include full error messages and steps taken.
• Specify affected hardware and provide screenshots.
• For patient-specific issues, include examples.

Support Resources & How to Contact Support

Support Hours & Channels

Cloud 9 Support:

Monday – Friday, 8 a.m. – 8 p.m. EST
Support Portal:
https://support.planetdds.com/hc/en-us

AI Chat Widget – available 24/7

Tickets created after hours will be triaged the next business morning.

Priority Definition & Examples

Critical Inoperability
Prevents access, no workaround (e.g., 
can't login).

Issue Hindering Workflow
Major feature impacted, workaround 
exists.

How To/Integration
Minimal loss, inquiry into product 
capabilities.

General Question
Feedback, minor errors, workaround 
exists.
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Cloud 9 Support Overview

How to Chat with Cloud 9 Support

1. Go to the Cloud 9 Portal: https://cloud9support.planetdds.com/hc/en-us
2. Use the Chat widget in the bottom right corner.
3. Type your question.
4. If your issue is not resolved, select ‘No’ when prompted.
5. The chatbot will create a ticket and a technician will follow up.

How to Enter a Support Ticket

1. Go to https://cloud9support.planetdds.com/hc/en-us
2. Click 'Submit a request'
3. Select ‘Cloud 9' in the ‘Request For’ field
4. Enter subject, description, and attach relevant files

Additional Resources

Cloud 9 Status Monitoring
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Introducing Account Management
At Planet DDS, we believe that exceptional customer experiences are built on deep 
partnerships and personalized support. Our Account Management team serves as your 
dedicated advocate, working to understand your unique business goals and connecting 
you with the resources and expertise needed to achieve measurable outcomes.

Personalized Customer Experience
With the Account Manager understanding your business goals, we partner with the below teams 
and connect you with the best resources to enable you to reach those desired outcomes. 

Organizational 
Understanding
We take time to deeply 
understand your practice 
structure, workflows, and 
strategic objectives to provide 
tailored guidance.

Driving Business 
Outcomes
Our focus is on measurable 
results that align with your 
growth targets and operational 
excellence goals.

Ongoing Solution 
Optimization
Through regular reviews and 
assessments, we 
continuously refine your 
platform usage to maximize 
value and efficiency.

Expert Teams Self-Service Resources

Professional 
Services

Assigned team of SMEs from implementation 
or training .

Cloud 9 Learning Center
On-demand training Support 

Services
Platform experts available to assist with questions or 
concerns Support@planetdds.com 

Product Share feedback, needs, and special access to betas Planet DDS Knowledgebase
On-demand resources for 

answers, tips and best 
practicesMarketing

Providing newsletters, podcasts, and events 
giving you access to hear and learn from other 
thought leaders

Structured Engagement Model
Our partnership is built on regular, meaningful touchpoints designed to keep you on track toward 
your goals:

Monthly Business 
Reviews

Quarterly Goal 
Optimization

Quarterly Product 
Roadmap Alignment

Bi-Annual Maturity 
Assessments
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Integrations

This section provides informational resources 
to help you get familiar with Planet DDS and our advanced 
system features available for use 
with Cloud 9.

Objectives:

• Review Planet DDS Integrations
Planet DDS offers features like Planet DDS Pay, Cloud 9 
Connect, and Cloud 9 Customer Backup Solutions (CBS) 
to enhance your workflows.

• Explore third-party integrations
Connect your Cloud 9 system with external trusted 
partners such as DentalXchange and Cloud 9 Signature 
to extend its capabilities.

• Understand API options
Find out how these connections can streamline your 
workflows and support your practice’s needs.



Planet DDS Pay
Revolutionize your practice’s payment experience 
Running a profitable dental practice can be challenging with inefficient and non- embedded 
payment systems. Our customers often face manual processes prone to errors, limited features, 
and disjointed systems.

Planet DDS Pay is a secure, unified and scalable solution designed for Denticon and Cloud 9 
platforms. With Planet DDS Pay customers can simplify financial operations, enhance patient 
satisfaction, and drive growth all with seamless integration and cutting-edge technology.

Why Choose Planet DDS Pay?

EFFICIENCY
Streamline billing and reduce 
administrative workload.

SCALABILITY 
A payment solution designed 
to grow with your practice.

PATIENT SATISFACTION 
Modern payment options improve 
patient experiences.

TRANSPARENCY
Simplified processes for practices 
and patients alike.

Automated Payment Posting
Post payments and refunds directly to Denticon
or Cloud 9, eliminating manual entry, reducing 
errors, and saving time.

Secure Payment Processing
Protect patient data with PCI-compliant 
encryption, ensuring world-class security and 
fraud prevention.

Surcharge
Offset credit card fees with surcharge 
functionality to reduce costs and enhance 
financial sustainability.

Flexible Payment Options
Accept a variety of payment methods, 
including credit, debit, ACH, and contactless 
options like Apple Pay and Google Pay.

Automated Onboarding
Streamlined registration and setup to reduce 
effort and accelerate time-to-value for new and 
existing locations.

Dedicated Support
Personalized onboarding and troubleshooting 
to maximize the benefits of Planet DDS Pay.

Enhanced Reporting & Reconciliation
Track trends, reconcile transactions, and resolve 
discrepancies with integrated reporting tools.

Card on File
Securely store payment details for seamless 
one-click payments, reducing billing delays and 
administrative effort.

Automated Financial Campaigns
Boost collections with automated text and email 
reminders, reducing overdue balances and 
improving cash flow.

STRIPE READER S700 
Portable and cost-effective

$249 Purchase or $15/month

Explore how Planet DDS Pay can transform 
your practice’s payment experience!

STRIPE WISEPOS E

Sleek countertop terminal
$349 Purchase or $25/month
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Cloud 9 Connect is a native patient communication platform designed specifically for orthodontic 
practices using Cloud 9. With automated reminders, two-way texting,and financial messaging, 
Cloud 9 Connect ensures your practice runs smoothly while reducing no-shows, improving 
collections, and enhancing patient satisfaction.

Built-In Patient Communications
BUILT DIRECTLY INTO CLOUD 9 ORTHODONTIC PRACTICE MANAGEMENT

Cloud 9 Connect

Why Cloud 9 Connect?

• 100% Build into Cloud 9

No third-party syncing, 
no extra dashboards.

• Automated &
Hands-Free

Free up staff time with 
pre-set communication
flows.

• Seamless Patient 
Experience

Keep patients informed, 
engaged, and on time.

• Scales with
Your Practice

Works for single offices 
or multi-location groups.

Connect’s automated appointment reminders
keep your schedule on track. Simply set your
routine, and Connect takes care of the rest.

With Connect, you can easily send appointment
reminders, one-off emails, and text messages,
even while you’re on the phone with patients,
keeping communication clear and convenient.
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Cloud 9 Connect | Built-In Patient Communications
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Automated 
Appointment Reminders
Reduce no-shows and 
keep schedules full.

• Fully configurable daily, weekly, or
custom schedules.

• Real-time triggers for scheduled, rescheduled, 
or canceled.

• Instant patient confirmation updates
inside Cloud 9.

Two-Way Texting
Text your patients, 
directly in Cloud 9.

• No external logins—text patients from their 
Cloud 9 profile.

• Permanent conversation history for complete
records.

• Smart routing: Send billing
questions to the right team
member.

Recurring Patient 
Campaigns
Automate ongoing 
engagement without 
manual effort.

• Automated email & texting campaigns
for birthdays, check-ins, and more.

• Mass messaging for office updates, 
closures, and promotions.

• Easy 3-step setup: Pick a template, 
select an audience, and schedule.

Financial Campaigns for 
Billing & Collections
Encourage timely payments 
& improve revenue cycle.

• Automated text & email billing 
reminders to reduce overdue accounts.

• Payment prompts & follow-ups to 
encourage timely payments.

• Direct links to payment portals for a 
frictionless experience.



Cloud 9 Signature is our integrated digital
forms tool that gives patients the 
convenience they need, while keeping 
your teams on top of their game.

Eliminate Chasing & Scanning
Keep records updated with automatically
uploaded patient forms.

Give Patients Flexibility
Complete mobile-friendly forms 
anywhere, on any device.

Start Fast
Access pre-built ortho forms for new-
patient intake, health history, and
consents.

Integrate Seamlessly
Add form or payment links to reminders 
using Cloud 9 Connect or other 
engagement tools.

HOW IT WORKS 

Collect patient information and 
consents securely via text, email, 
or desktop.

Customize forms with your practice 
logo and colors.

Store completed PDFs automatically 
in each patient’s Cloud 9 record.

Book new patient appointments 
directly through the online form 
so they’re instantly visible in
your schedule.

Complete forms in-office on kiosks 
or workstations.

Front Office
Simplified 
workflows and 
reduced follow-up

Clinicians
Accurate records 
and easier
chart access

Patients
Faster check-ins
and a smoother
experience

WHO BENEFITS 

GO PAPERLESS WITH DIGITAL FORMS

Cloud 9 Signature

Cloud 9 Signature
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Pre-built ortho form templates

Mobile-friendly patient forms

Automatic form storage in Cloud 9

Form and payment link delivery via text, email, or website

Integration with Cloud 9 Connect and other engagement tools

Custom forms and unlimited form count

Reputation management dashboard (reviews and responses)

LIMITED UNLIMITED 

Boost the Patient Experience with Integrated Digital Forms.

Cloud 9 Signature

Choose the plan that best fits your practice:

Benefit from Seamless Interoperability

Pair with Cloud 9 Connect or any integrated patient engagement tool to ensure no patient falls through the cracks.

See the full list of integrated partners: planetdds.com/api-partners-grid

Cloud 9 Connect
Automated reminders, two-way texting, and campaigns

Planet DDS Pay
Secure, simplified patient payment processing
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How orthodontic imaging evolves with CephX inside Cloud 9
BEFORE AFTER 

Time-consuming manual ceph tracing 
introduces inconsistencies in

treatment planning.

Faster, more consistent treatment planning
is powered by AI-driven ceph tracing.

Juggling multiple logins and 
platforms fragments the workflow and 

slows productivity.

Simplified workflows with imaging 
are accessed directly inside Cloud 9.

Managing imaging and treatment data 
across locations adds administrative 

overhead and reduces visibility.

Centralized imaging workflows improve 
consistency and oversight across

multi-location organizations.

Limited visual tools for case presentation
make patient communication less effective.

More confident treatment discussions are 
supported with interactive 3D visualizations.

High case volumes and manual planning 
demands contribute to provider fatigue 

and slower turnaround.

Efficient case management
reduces repetitive work and cognitive 

load for clinicians.

AI-POWERED CEPH TRACING AND 3D IMAGING, BUILT DIRECT LY INTO CLOUD 9

Cloud 9 + CephX Integration

Cloud 9 + CephX Integration

THE SHIFT 
From Manual to Intelligent Imaging
Orthodontists often spend valuable time 
tracing films or working in third-party tools just
to plan and present complex cases.

CephX changes that. With AI-powered ceph 
tracing and 3D imaging built into the patient 
record, clinicians can analyze and visualize 
anatomy quickly and consistently without 
leaving Cloud 9.
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AI-Driven Precision
FDA-cleared cephalometric tracing and 3D
segmentation improve accuracy and 
confidence in treatment planning.

Efficiency at Scale
Simplified workflows support busy 
orthodontic practices and DSOs without 
adding extra tools or steps.

Consistent Results Across 
Every Location
Centralized, AI-assisted imaging ensures 
diagnostic uniformity, reduces oversight 
burden, and supports scalable growth.

Engaging Visual 
Communication
The embedded 3D viewer enhances case
clarity, builds patient confidence, and
supports higher case acceptance during
consults.

Cloud 9 + CephX Integration

Experience AI imaging inside Cloud 9.
Simplify complex cases with integrated ceph tracing and 3D imaging.

The Difference from Day One
Teams using CephX within Cloud 9 report:

Save 5–10 minutes per ceph analysis
(≈8 hours per provider each month)¹

Faster analyses with reduced 
operator fatigue vs. manual tracing²

No extra logins or software 
downloads inside Cloud 9

Greater consistency across staff with 
AI-assisted outputs

¹ Public clinician testimonial (CephX)
² Peer-reviewed study: Comparison of AI-assisted cephalometric 

 analysis and orthodontist-performed digital tracing analysis, 
Progress in Orthodontics, 2024.

Scalable. Compliant. Built for Growth.
CephX and Cloud 9 work together to scale with the accuracy, security, and reliability that

enterprise dental organizations demand.

Enterprise-ready
Supports multi-location 
DSOs with centralized 

imaging standards

Data-secure
HIPAA-aligned and SOC 2 
Type 2 certified to protect 

patient data

Performance-driven
Deliversconsistent imaging

accuracy and scalability
across providers and

locations
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